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INSTALLING NETCARD

Windows 95/NT
1. Locate the folder containing the NetCard software on your hard disk or CD 

ROM.
2. Double click on the "Setup.exe" icon.    (If you downloaded the Trial 

Version from an on-line service or website, double click on the 
"netcard.exe" icon.)

3. The NetCard setup program will begin.    Follow the on screen instructions 
to proceed with installation.

Macintosh
1. Locate the folder containing the NetCard software on your hard disk or CD 

ROM.
2. Double click on the "Install" icon.    (If you downloaded the Trial Version 

from an on-line service or website, double click on the "????" icon.)
3. The NetCard installation program will begin.    Follow the on screen 

instructions to proceed with installation.

GENERAL QUESTIONS AND ANSWERS

Q. What is NetCard?

A. PictureWorks NetCard is a revolutionary Internet software application that 
turns boring old e-mail into exciting new iMail. NetCard adds the power of 
visual impact to your e-mail messages by taking your pictures or movies and 
seamlessly integrating them in a familiar postcard format with your 
personalized voice and text messages. The front of the NetCard contains your 



picture or movie complete with any voice message you choose to add. The 
back of the NetCard holds your text and the addressing information for 
automatically sending your NetCard over the Internet or your internal mail 
system. And best of all, NetCard works its magic without the hassle or steep 
learning curve of complicated multimedia programs.

Q. What is a 'Trial Version'?

A. The Trial Version of NetCard allows you to try NetCard without having to 
purchase the full product.    With the Trial Version, you can send five NetCards,
to disk or via email.    After you have created and sent five NetCards, you will 
need to purchase NetCard to continue using it.    When you start the Trial 
Version software, a dialog reminds you how many NetCards you have 
remaining and offers the option to buy it.    With a modem or Internet 
connection, you can unlock the software instantly.

Q. What is iMail?

A. iMail is a term we coined at PictureWorks. iMail stands for image mail to 
indicate the added visual dimension that NetCards bring to existing e-mail. 
NetCard is so unique and different we just couldn't see describing it and its 
underlying technology as boring old e-mail only better.

Q. Is NetCard hardware, software or a combination?

A. NetCard is a software application. It takes its name from interNET postCARD.
Besides the general system requirements, NetCard does not require any 
additional hardware or software to run.

Q. Do the people I send NetCards to need to have NetCard software to receive 
and view them?

A. No. NetCards travel the Internet (and internal e-mail systems) with their own 
self-contained viewer applet. All someone needs to receive and experience a 
NetCard is an e-mail address and e-mail software. In fact you can even save 
NetCards to disk, copy them to a floppy and then send the floppy via regular 
mail to anyone with a computer for their viewing pleasure.

Q. How do I get images onto the NetCard?

A. You can either select the image on your desktop and drag it onto the front of 
the NetCard, or if you prefer, click the Import button on the front of the 
NetCard to invoke the import dialog.

Q. How long can my voice message recording be?



A. That really depends on a couple of things like how much memory your system 
has, and for Windows, the quality level you choose to record at. Generally 
speaking you can record up to two and one-half minutes telephone quality 
voice annotation. We recommend keeping the voice recording to less than 10 
to 15 seconds to reduce email transfer times.

Q. Which e-mail systems does NetCard support?

A. NetCard works with any e-mail system that supports attachments. It does this 
by saving your completed NetCard in the NetCard outbox folder. You then 
include the finished NetCard as an attachment to your e-mail message and send
it as you would any e-mail.

For the most popular e-mail systems, however, NetCard works even better by 
allowing you to send automatically and directly from the NetCard application 
itself. With these systems you simply create the NetCard, address it and click 
send; NetCard takes care of the rest.

Q. What platforms can I send NetCards on and to?

A. You can send interactive NetCards complete with pictures or movies and voice 
annotation from Macintosh to Macintosh or Windows to Windows.

If you need to send NetCards from Windows to Mac or vice versa, NetCard 
allows you to do this by automatically creating a JPEG image that contains 
both sides of the NetCard. When sending NetCards in this fashion you only 
send still images without voice annotation, but they're still a world apart from 
regular e-mail.

Q. How long does it take to send or receive a NetCard?

A. That depends on the image type, length of voice annotation and the speed of 
your modem or network connection. NetCard automatically compresses the 
image, voice annotation, text and self contained player application in order to 
minimize file size and transmission time. A NetCard with a JPEG image and 5 
seconds of voice annotation with text message will usually compress into a file
of less than 400K and take less than 4 minutes to send or download with a 14.4
bps modem. Movies are much larger than still images and require a longer 
transmission time.

Q. Can I print a NetCard I received?

A. Yes, NetCards can be printed if they were sent in the optional JPEG format.

Q. Once I receive a NetCard can I save or forward it?



A. Yes. NetCards, complete with their self-contained viewer, may be saved to disk
for future viewing. NetCards can also be forwarded via e-mail to others who 
might have an interest in the subject matter.

TECHNICAL QUESTIONS AND ANSWERS

Q. Which operating systems does NetCard support?

A. NetCard supports Windows 95, Windows NT 4.0, and Macintosh system 7.1.1 
(or later).    Windows 3.1 users can view NetCards; however, they will    not be 
able to create new NetCards.

Q. How does NetCard support images and movies?

A. Images and movies can be dragged from folders and the desktop directly onto 
the front of the NetCard or opened using the Import button. Still images are 
automatically resized to fit the NetCard.    The image is stored in the NetCard 
as a 24-bit image, regardless of its original bit-depth.    Highly efficient 
compression is used to shrink the size of the incorporated image. Movies are 
stretched to display at 320x240 pixels on Windows. The original recording size
is not changed.

Q. Which still image formats does NetCard support?

A. NetCard supports the following still image file formats:
JPG—JPEG file format 
BMP—Windows bitmap (Windows)

          PICT—PICT file format, including compressed PICT (Macintosh)

Q. Which movie formats does NetCard support?

A. NetCard supports the following movie file formats:
AVI—Video for Windows format (Windows)
MOV—QuickTime movie format, including QuickTime VR (Macintosh)
Note that for QuickTime VR movies to be viewed, the QuickTime VR system 
components must be installed on the viewing machine.    The necessary files 
are available from Apple at no charge via their website at 
http://quicktime.apple.com.

Q. Does NetCard compress images and movies before sending?

A. Still images are automatically compressed by NetCard into small, high quality 
images, maximizing sharpness while minimizing file size to reduce transfer 
times. Movies should be compressed to minimize the size of the NetCard.    
NetCard for Windows will prompt you to compress the movie if it is not 
already compressed.    We recommend you use one of the standard compression



formats that comes with Windows 95, such as Radius Cinepak, to assure it will
be viewable by your recipient. (See the Tips and Techniques section for more 
information.) If the movie is already compressed, NetCard sends the file as is.   
Most QuickTime movies for the Macintosh are compressed when they are 
created; thus, NetCard for Macintosh sends movies without checking for 
compression. 

Q. Can I record a voice message to send with my NetCard?

A. Voice recording requires that your computer be outfitted with a sound system 
and a microphone.    For Windows, we recommend a MPC II compliant sound 
card, standard with most computers sold since 1995.    Nearly all Macintosh 
systems are pre-configured for sound recording and playback.

Q. Do voice recordings make the NetCard file size large?

A. Yes. To help keep the size of your NetCard to a minimum, we recommend 
using telephone quality sound recording. In Windows, you can set this when 
the Microsoft Sound Recorder opens after you click the Record button.    On 
the Edit menu, click Audio Properties and select Telephone Quality as the 
Preferred Quality setting. For more information, click Help Topics on the Help 
menu in Microsoft Sound Recorder.

On the Macintosh, NetCard automatically sets the recording quality to 
telephone and allows up to 1.5mb of recorded sound (or the maximum 
available ram, which ever is less).    This typically results in a maximum 
recording time of 2.5 minutes.

Q. What is the difference between automated sending and saving my NetCard to 
disk?

A. PictureWorks NetCard provides two alternatives for sending NetCards via e-
mail:    automatically via select popular e-mail software; or manually by saving
your NetCard to disk and then manually attaching it to any e-mail message.    
Automatic delivery results in an e-mail message being created, the NetCard 
attached to the message, and the placement of the message into the e-mail out-
basket.    

Q. Which e-mail systems support automated sending?

A. The following e-mail systems support automated sending:

AOL (America Online)—Windows and Macintosh (except for Windows NT, 
the 32-bit version 3.0 for Windows 95, and 3.0 preview for Macintosh). 
Version 3.0 for Windows (16-bit; included on the NetCard CD) is strongly 
recommended for Windows systems if automated sending is desired.    



Macintosh version 2.7 is recommended for use on Macintosh systems. You 
should install AOL for Windows before you install NetCard; otherwise, you 
will need to reinstall NetCard to ensure the AOL drivers are placed in the 
proper location.

Microsoft Exchange or Windows Messaging—Windows
Windows 95 includes Microsoft Exchange as a standard communications 
software application.    You may be familiar with it as "Inbox", the icon that 
displays on the desktop when you first install Windows.    To send e-mail using 
Microsoft Exchange, you must first install the Internet mail services software.   
This enhancement to Microsoft Exchange is included in the Microsoft Plus! 
software available at retail, or via free download from Microsoft's web site at 
http://www.microsoft.com/windows/software/updates.htm or directly from 
their ftp site at ftp://ftp.microsoft.com/Softlib/MSLFILES/inetmail.exe. Note 
that the latest version of Microsoft Exchange has been renamed Windows 
Messaging.

Eudora—Windows and Macintosh
The following Eudora versions support automated sending: Eudora Pro 3.0 for 
Windows and Macintosh, Eudora Light Windows version 1.5.4, Eudora Light 
Macintosh version 1.5.5. Note that on Windows systems, you must have 
Eudora configured to support MAPI.

Q. If I'm using an e-mail system that doesn't support automated sending or if I 
don't want to automatically send my NetCards, what can I do instead?

A. If you are using e-mail software that isn't supported by NetCard's automated 
sending or if you prefer to create and address your own e-mail message to 
attach a NetCard to, select the Save to disk in NetCard outbox folder option in 
the NetCard Preferences dialog.    When you do so, all NetCards are sent to the 
outbox folder located in the folder where NetCard was installed.    After your 
NetCard is saved to disk, you can then attach it to an e-mail in the same 
manner you would attach any other file in your e-mail software.    Refer to the 
documentation that accompanied your e-mail software for more information 
regarding attaching files.

Note that NetCards do not have to be sent via e-mail to share with others.    By 
selecting the Save to disk... option in the Preferences dialog, you can save your
NetCard locally and then copy it to floppy disk, a server or other removable 
media to make available to others.

Q. Which e-mail systems support address books in NetCard?

A. Both Microsoft Exchange and Eudora support direct access to their address 
books from within NetCard. When you select Microsoft Exchange or Eudora 
for automatic delivery, a button that looks like a card file appears on the back 



of the NetCard.    Click the button to open the address book and select 
recipients.

Q. What is the difference between creating a NetCard as a JPEG file versus 
attaching a Player?    I didn't know which one to choose in the Preferences 
dialog.

A.    The delivery format you choose will depend on three factors: The operating 
system used by the recipient, your desire to send an interactive NetCard, and 
your desire to send voice or movies. When you attach the Player, NetCard 
creates self-playing electronic postcards to send to users using the same type of
computer operating system as you are; i.e., Windows to Windows or Macintosh
to Macintosh.    If you want to send voice messages, movies, or interactive two-
sided NetCards with sound effects, choose the option in the Preferences dialog 
that attaches the Player. 

PictureWorks NetCard can also create a compressed JPEG file in which an 
image of the front of the NetCard is placed above an image of the back.    JPEG
files can be viewed by thousands of programs, including many e-mail, word 
processing, and web browsers.    This option is useful if you will be sending a 
NetCard to users of other operating systems or if you are not interested in 
sending voice, movies, or the interactive NetCard interface.    Sending as a 
JPEG file can save on transmission time as the NetCard with Player is typically
400K in size while the JPEG itself is rarely larger than 150K.

TROUBLESHOOTING

Problem: Recipients are unfamiliar with e-mail attachments and don't know how 
to view their NetCards.

Remedy: Send brief instructions with your e-mail.
When you autosend a NetCard, the recipient receives brief instructions on how 
to view it. If you save your NetCard to disk and then attach it yourself to an e-
mail, you may want to consider writing some helpful instructions in the text of 
your e-mail. Some examples of what you could include are listed below; for 
further ideas, scan the rest of the troubleshooting topics in this section.
All recipients, in general: Many e-mail systems let you double-click an 
attachment to view it. If this doesn't work, or if you want to save the NetCard 
for later viewing, save the attachment to disk. Once the NetCard attachment is 
saved, you can view it by finding the file name on the drive where you saved it
and double-clicking it. (For Windows 3.1, you can use File Manager; for 
Windows 95, use Windows Explorer.) 
Microsoft Exchange/Microsoft Messaging/Microsoft Internet Mail users: 
Open the e-mail message and locate the attachment. Double-click it to view it 
immediately and/or right-click it and select Save As to save it. 
America Online (AOL) users: Windows: Open the e-mail message. Click the 



Download File button in the e-mail's message window. AOL usually puts e-
mail attachments in the Download directory where AOL is installed. 
Macintosh: Open the e-mail message and click the Download Now button. 
Click Save to copy the NetCard Player to your disk. When you see 'The file 
has been transferred' message, click OK.
Netscape Navigator users: Open the e-mail and click the attachment listed at 
the bottom. In the Save As dialog, save the file to the directory of your choice. 
Eudora users: Windows: With the e-mail message open, look at the bottom of 
the message for the directory where the NetCard attachment was saved. Then 
use File Manager (Windows 3.1) or Windows Explorer (Windows 95) to locate
the NetCard file; double-click it to view it. 
Macintosh: With Eudora and the e-mail message open, double-click the file 
listed as the Attachment at the bottom of the message.
cc:Mail users: Open the e-mail and double-click the NetCard attachment. If 
the NetCard doesn't come up, shift double-click the NetCard. If that still 
doesn't work (the recipient may see a message that says that no viewer is 
installed or no association is found), save the attachment to disk with the Save 
As command on the File menu. 
Claris e-mailer users: With the e-mail message open, double-click the 
NetCard icon in the Enclosures box. 

Problem: Recipients using Windows aren't receiving NetCard files named .EXE   
(NetCard Player file) or .JPG (NetCard JPEG image).

Remedy: Tell recipients to change the file name extension.
For numerous reasons, it is possible that the name of the NetCard file you sent 
was changed during transfer over the Internet.    The solution is simple: The 
recipient should make sure that the attached file's name ends in ".EXE" if it 
was a NetCard Player file, or in ".JPG" if it was a NetCard JPEG file.    If it 
does not, the recipient should save the attached file to disk, renaming it to 
"NCPlayer.EXE", "NCImage.JPG", or something similar.    The important part 
of the name is the ".EXE" or ".JPG". (You can usually assume the attachment 
is a Player file (EXE) if it is larger than 200K; a NetCard JPEG attachment 
would likely be smaller.)

Problem: Recipients are having trouble receiving NetCards.
Remedy: NetCards should be sent using MIME format.

To assure NetCards are received properly by other e-mail users, use the MIME 
message format when sending NetCards. Most e-mail software is configured to
send messages in this format by default. In Microsoft Exchange, you can check
this by clicking Services on the Tools menu. Select Internet Mail, click 
Properties, and then click Message Format.    'Use MIME when sending 
message' should be checked. 

Problem: Recipients are having trouble decoding NetCard attachments.



Remedy(1): In Microsoft Exchange, do not send NetCard messages using Rich 
Text Format. 
Unless the recipients also use Microsoft Exchange they will not be able to 
decode the NetCard attachment if it was sent using Rich Text Format. To make 
sure you are not sending Rich Text messages, check the Properties for the 
addressee(s) in the Address Book. The checkbox    'Always send messages in 
Microsoft Exchange rich text format' should NOT be checked unless you are 
positive they are using Microsoft Exchange.

Remedy(2): Manually UUDecode the NetCard attachment, if possible.
Users of Microsoft Network and Compuserve receive e-mail attachments that 
are UUEncoded. In order to view their NetCard attachment, they will need to 
UUDecode it.

Problem: There seems to be a compatibility issue with my Diamond Stealth 3D 
drivers.

Remedy: Upgrade drivers.
If you have Diamond Stealth 3D drivers that are dated before 9-24-96 you 
should update your drivers to the newest version. You can get these drivers on 
Diamond Multimedia's site at http://www.diamondmm.com.

Problem: My Progressive JPEG image doesn't display properly on my 
Macintosh.

Remedy: There is a compatability problem with Progressive JPEG images and 
NetCard.    If you have such a file, convert it to a standard PICT, JPEG, or 
QuickTime compressed image prior before loading it into NetCard.

Problem: When I try to record audio in Windows, I get a message that the Sound 
Recorder is not installed.

Remedy: Rerun the Windows setup program and do a Custom Install. Under 
Multimedia options, check Sound Recorder.

TIPS AND TRICKS

Importing Sounds - Windows 
The voice recording feature of NetCard utilizes the standard sound recording 
function included with Windows 95 and Windows NT version 4.0, the Sound 
Recorder.    The recorder allows you to insert standard WAV files into the 
recording.    WAV files are used for the standard system sounds and are readily 
available for download from many Internet sites and American Online.    To 
add a sound or music WAV to your NetCard, click the microphone icon on the 
front of the NetCard. In the small window that opens, click Insert File on the 
Edit menu, browse to locate the WAV file you want to import and then click 
the Open button. You can play the sound to test it; then close the dialog to add 
the sound to your NetCard.



Note: The capability to import pre-recorded audio files is not provided in the 
Macintosh version.

Playing QuickTime VR movies - Macintosh
NetCards are an excellent way to send VR movies to others to view.    Like any
QuickTime movie, QuickTime VR movies can be dragged from the desktop to 
the open NetCard or imported using the import file button.    In order for 
recipients to view the movie, they must have a Macintosh with the QuickTime 
system components installed.    The system components are available for free 
download from Apple's website at http://quicktime.apple.com.

Sending multiple NetCards in one e-mail message
Sending multiple NetCards in a single e-mail message is easy. First, click the 
Preferences button in NetCard and set Delivery Service to 'Save to disk in 
NetCard outbox folder'.    Then, create and "send" as many NetCards as you 
like.    They will all be placed in the outbox folder where you installed 
NetCard. You can now start your e-mail software, create an e-mail message, 
and attach one or more of the NetCards you created. Address the message and 
send it as you would other mail.
Optionally, if you have a compression program such as WinZip (Windows) or 
StuffIt (Macintosh), you can create a single compressed file to attach to your e-
mail message.    If you do this, be sure that the recipient of the compressed 
attachment has the necessary software to decompress the files.

Sending a single NetCard to many people
You can send a single NetCard to many people in several ways. One way is to 
save the NetCard to disk (see above), create an e-mail with as many addressees
as you want, and attach the NetCard. Another way that may be a real time 
saver is to send the NetCard to a group of addresses, if your e-mail allows the 
creation of groups. This may be a time saver, particularly if you send to the 
same list of names often. For example,    you can automatically send a NetCard
to a group of people by creating a group address (AOL), distribution list 
(Microsoft Exchange), or nickname (Eudora for Macintosh). Then, in NetCard,
create the NetCard and enter the group address name in the 'To:' field on the 
back of the NetCard. When you send the NetCard, assuming you have 
specified in Preferences to send automatically, each of    the individual 
addressees in the group will receive the NetCard.

Compressing audio and video files 
When you send compressed audio or video as part of your NetCard, the 
recipient will need to have the same audio or video codec installed in order to 
play it. We think the best quality for video compression is provided by Intel 
Indeo Interactive 4.x codec, which comes standard with Windows NT 4.0; 
versions for Windows 95 and Windows 3.x are available from Intel's web site 
at www.intel.com. Otherwise, use one of the codecs your recipient is most 



likely to have:
Windows 95/Windows NT

Intel Indeo R3.2 (video) 
Radius Cinepak (video)
Microsoft PCM Converter (audio)

Windows 3.x
Radius Cinepak (video; requires Video for Windows installed)
Microsoft PCM Converter (audio)
Microsoft ADPCM Codec (audio)

Macintosh
QuickTime (recipient needs at least version 2.1 installed)

Converting York FotoFloppy Images for Use with NetCard
York Photo Labs is offering a special, no charge conversion of your pictures on
film to floppy disk (with paid film processing).    If you take advantage of this 
wonderful offer, you can use these converted images with PictureWorks 
NetCard by installing and running the software included with the images on 
the FotoFloppy disk, saving the images as BMP (Windows) or PICT 
(Macintosh) files, and importing them directly into NetCard.

Be sure to visit our website at http://www.pictureworks.com for additional 
information, special product offers, and announcements of new products.

Register today!    By registering, you will be notified of new products and 
updates and be eligible for special upgrade prices.

Thanks again for purchasing PictureWorks NetCard.


